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¢ La copie de données de séquences musicales disponibles dans le commerce et/ou de fichiers audionumériques/graphiques/vidéo est
strictement interdite, sauf pour un usage personnel.

Les copyrights du logiciel et de ce mode d’emploi sont la propriété exclusive de Yamaha Corporation.

 Toute copie du logiciel ou de ce mode d’emploi en tout ou en partie, par quelque moyen que ce soit, est expressément interdite sans le
consentement écrit du fabricant.

* Yamaha n’offre aucune garantie quant a 'usage du logiciel ou de la documentation et ne peut étre tenu pour responsable des résultats de
'usage de ce mode d’emploi ou du logiciel.

* Les captures d’écran qui illustrent ce mode d’emploi sont proposées a titre indicatif et peuvent étre Iégerement différentes de celles qui
apparaissent sur votre ordinateur. Les affichages représentés sont ceux de la version pour Windows, mais les modalités de fonctionnement
sont identiques sur la version pour Mac.

* Windows est une marque déposée de Microsoft® Corporation aux Etats-Unis et dans d’autres pays.
* Apple et Mac sont des marques de commerce dApple Inc., déposées aux Etats-Unis et dans d’autres pays.
* MIDI est une marque déposée de I'Association of Musical Electronics Industry (AMEI).

¢ Les noms de sociétés et de produits qui apparaissent dans ce mode d’emploi sont des marques commerciales ou déposées appartenant a
leurs propriétaires respectifs.

La licence utilisée dans ce logiciel est décrite dans le fichier « Licenses.txt » inclus dans le dossier d'installation de I'application.

Ce mode d’emploi part du principe que vous étes déja habitué aux opérations liées a I'environnement Windows/Mac. Si tel n'est
pas le cas, veuillez vous reporter au mode d’emploi fourni avec votre logiciel Windows/Mac avant d’utiliser cette application.
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Introduction

Présentation de MIDI Song to Style

L’application MIDI Song to Style convertit automatiquement les morceaux MIDI (SMF : fichier MIDI standard ; extension : .mid) en
fichiers de style (.sty), ce qui vous permet de reproduire les morceaux souhaités en tant que styles sur I'instrument.

Ordinateur

MIDI Song to Style

Instrument

Morceau Style
MIDI (.mid) | |:> (-sty) |

Transfert par céable
USB ou via lecteur
flash USB

Vous pouvez également écouter et modifier les données converties :
- En reproduisant des morceaux MIDI chargés et en modifiant les sonorités affectées a chaque canal.
- En écoutant et en modifiant les styles convertis.

Précautions a prendre lors de I'utilisation de I’application

» Cette application (ci-aprés dénommée I'« application ») collecte de maniére anonyme des données d’utilisation des fonctions
dans le but d’'améliorer la qualité du service et de promouvoir des produits et services associés. Les données réelles que vous
modifiez ne seront pas collectées. Si vous ne souhaitez pas transmettre le statut d'utilisation, vous pouvez désactiver cette
option sous Réglages (page 12).

» Cette application a été principalement congue pour convertir des morceaux MIDI en fichiers de style ; elle n’est pas faite pour
servir de lecteur audio. Veuillez noter que les fonctions d’apergu suivantes de I'application servent uniquement de support pour
effectuer des modifications, et que nous ne garantissons pas I'entiére compatibilité de la reproduction audio, etc.

- Reproduction de morceaux MIDI
- Reproduction de styles convertis
* Cette application peut uniquement étre utilisée avec les modeles compatibles avec le format SFF GE (par exemple, Genos2).



Installation

Connexions et installation

Il est possible d’utiliser cette application de deux maniéres différentes : en la connectant a I'instrument, ou en lutilisant
simplement de maniére autonome sur un ordinateur.

B Utilisation de I’application en connectant I’ordinateur sur I'instrument

Cette méthode est recommandée, car elle vous permet d’écouter toutes les modifications comme elles seront réellement
entendues.

Exemple de connexion

Ordinateur

Haut-parleurs
Instrument de linstrument
—— Ou sortie audio

0))

MIDI Output Device - Cable USB

MIDI Input Device

Pour obtenir des instructions sur la maniere de connecter I'ordinateur a l'instrument, reportez-vous au mode d’emploi
correspondant.

Lorsque vous vous connectez a I'instrument, vous pouvez :

* Reproduire des fichiers MIDI avec les sons de l'instrument.

* Ecouter les styles convertis avec les sons de l'instrument.

 Enregistrer (transférer) les fichiers de style convertis directement dans l'instrument.

» Spécifier des accords sur le clavier de I'instrument tout en écoutant les styles convertis.

NOTE

Lorsque vous spécifiez des accords depuis I'instrument tout en écoutant sur cette application, assurez-vous que la touche [ACMP] de
linstrument est désactivée. (Si vous utilisez I'instrument avec les fichiers de style converti chargés, activez [ACMP] comme vous le
faites habituellement.)

Réglages requis :

Ouvrez [Preference] -> [MIDI Device] dans le menu situé en haut de 'application, puis réglez le port comme suit.
e MIDI Input Device : sortie MIDI de I'instrument

* MIDI Output Device : entrée MIDI de l'instrument

NOTE

L’entrée et la sortie doivent étre toutes deux réglées sur 'instrument pour un transfert correct des fichiers.



Installation

B Utilisation de I’'application de maniére autonome uniquement avec un

ordinateur
Vous pouvez tout simplement utiliser cette application seule, sans avoir a connecter I'instrument sur 'ordinateur. Cette méthode
ne permet pas de reproduire aussi fidelement les sonorités et les styles, mais elle vous permet de travailler uniguement avec

'ordinateur.

Exemple de connexion

Ordinateur

Haut-parleurs de

- o 'ordinateur
MIDI Output Device Instrument Dispositif
— 5| virtuel —» | audiointégréa |— Q )))
intégré I'ordinateur
Clavier MIDI, etc.

s T i
v U

En vous servant uniquement d’un ordinateur, vous pouvez :

* Reproduire des morceaux MIDI en utilisant les sons de l'instrument virtuel intégré a l'application (*1).

* Ecouter des styles convertis avec les sons de l'instrument virtuel intégré a I'application (*1).

» Enregistrer le fichier de style converti sur 'ordinateur ou le transférer vers I'instrument au moyen d’un lecteur flash USB.
» Spécifier des accords sur la palette d’accords (page 13) tout en écoutant les styles convertis.

*1) Les sons ne seront pas reproduits avec une précision irréprochable.

Réglages requis :

Ouvrez [Preference] -> [MIDI Device] dans le menu situé en haut de I'application, puis réglez le port comme suit.
e MIDI Input Device : aucun (réglez si vous disposez d’'un clavier MIDI, etc.)

* MIDI Output Device : MIDI Song to Style Synth, ainsi qu’un dispositif audio pour émettre le son



Installation

B Importation de la liste des sonorités

Lorsque vous modifiez les sonorités de chaque canal d’'un morceau MIDI préalablement chargé dans cette application (page 25),
vous pouvez sélectionner des sonorités dans la liste des sonorités intégrée a I'application. La liste des sonorités pour la version
1.00 du micrologiciel du Genos2 est la liste initialement chargée dans cette application.

En important la liste des sonorités, vous pouvez faire correspondre la liste des sonorités de cette application avec celle de
linstrument lié.

Pour les produits compatibles, des informations sur le fichier liste des sonorités pour MIDI Song to Style sont disponibles sur la
page produit du site Web Yamaha (https://www.yamaha.com/).

1. Sélectionnez [Edit] -> [Import Voice List] dans le menu situé en haut de I’application.
Une fenétre de sélection de fichier s’ouvre.

2 = Sélectionnez la liste des sonorités (.txt) pour votre instrument.

La liste des sonorités de I'application sera mise a jour avec la liste chargée.
Si aucun message d’erreur n’apparait, le chargement est terminé.



Guide de référence rapide/Présentation

Comment utiliser MIDI Song to Style

B Mode d’utilisation le plus simple : conversion et transfert

Ordinateur

MIDI Song to Style

Instrument

1
Morceau
MIDI (.mid) I l:>

Style
(-sty)

Transfert par cable
USB ou via lecteur
flash USB

Fichier de morceau MIDI
Format de fichier MIDI standard
(.mid)

Le morceau MIDI que vous avez transféré est automatiquement analysé et converti en style, ce qui vous permet de
reproduire et de modifier le style converti dans I'application (page 16).

2 = Transférez les résultats de I’analyse vers I'instrument sous forme de fichier de style. (Cliquez
sur I'icéne )
Il existe deux méthodes de transfert :
A) Enregistrez le fichier de style directement dans I'instrument au moyen du cable USB (Enregistrer dans
l'instrument).
(Vous pouvez transférer le fichier lorsque I'ordinateur est connecté a I'instrument via un cable USB. Reportez-vous a
la page 3 pour les réglages nécessaires.)
B) Enregistrez sous forme de fichier de style sur un lecteur flash USB, puis transférez le fichier vers
I'instrument (Enregistrer sur I'ordinateur).

3. Jouez sur I'instrument avec le style transféré.



Guide de reférence rapide/Présentation

B Nouvelle analyse en modifiant les conditions d’analyse

Si les résultats de la conversion de style automatique ne sont pas a la hauteur de vos attentes, vous pouvez modifier les
conditions de I'analyse et reconvertir le morceau MIDI chargé.

* Veillez a exclure le canal mélodique principal ainsi que les autres canaux que vous ne souhaitez pas inclure dans le style (page 19).

B Modification du style automatiquement converti

Vous pouvez modifier manuellement le style automatiquement converti comment suit.

* Modifier la plage extraite d’'un morceau MIDI en tant que section (page 20)

* Réorganiser les sections (page 21)

» Sélectionner une nouvelle plage et I'affecter & une section (page 22)

* Modifier les affectations de canaux MIDI de chaque partie de style pour chaque section (page 24)
* Modifier la sonorité pour chaque canal d’'un morceau MIDI (page 25)

* Modifier/réinitialiser le volume pour chaque partie d’un style (page 26)

* Modifier le temps du style ou l'indication de la mesure (page 26)




Guide de reférence rapide/Présentation

Enregistrement ou chargement des données en cours de modification (projet)

Vous pouvez enregistrer ou charger les morceaux MIDI chargés, y compris les informations analysées et les contenus modifiés,
sous forme de fichier de projet dans un format de fichier dédié (.sts).

Les contenus suivants sont enregistrés dans le fichier de projet :

¢ Contenu du morceau MIDI chargé (fichier SMF)

¢ Résultats de I'analyse automatique d’'un morceau MIDI

» Statut de modification du style, y compris les affectations de sections et de parties

B Enregistrement d’un projet
Ouvrez [File] -> [Save Project] dans le menu situé en haut de I'application, et spécifiez 'emplacement de sauvegarde.

B Chargement d’un projet
Ouvrez [File] -> [Open Project] dans le menu situé en haut de I'application, et sélectionnez le fichier de projet souhaité. Vous
pouvez également simplement faire un glisser-déposer du fichier de projet dans 'application.




Fonctions (description de I’affichage)

Flux d’affichage

Voici une présentation succincte du flux d’affichage aprés démarrage de I'application.

Au démarrage

Réglages MIDI

Autres réglages

Chargement du fichier

Accueil (Easy)

Palette d’accords (fenétre séparée)

LLILLLE

Enregistrement des styles

»
LY
LY
LY
B
<]
5]
e
Y
]

Modification des paramétres de section




Fonctions de I'affichage

Fonctions (description de I'affichage)

Cette section décrit ce qu'il est possible de faire sur chacun des écrans présentés précédemment.

B Ecran d’accueil (Easy)

B MIDI Song to Style
File Edit Preference Help

>

>

g

Intro "

»

Main A Main B

‘ <

»

L rnA J|_rinB

==
L

Intro I"

>
Main C

Is)
=

>

N ril G

_ rinD

»
Main D

el
=t

»>

(D Contréle la reproduction de morceau MIDI

(2 Ouvre I'écran de chargement d’un nouveau fichier

(3 Change le mode d’affichage d’accueil (Easy < Edit)

@ Ouvre la fenétre de réglages MIDI (page 12)

(® Ouvre la fenétre des autres réglages (page 12)

(® Pour reproduire des sections du style converti (page 16)

(@ Affiche I’accord spécifié durant la reproduction du style et ouvre la fenétre de palette d’accords

(page 13)

Ouvre I’écran d’enregistrement de style (page 18)



Fonctions (description de I'affichage)

B Ecran d’accueil (Edit)

) MIDISong o Syle

File Ed elp

Les fonctions (D a (® sont identiques a celles de I’écran d’accueil (Easy).
(9 Effectue une nouvelle analyse aprés modification des réglages d’analyse automatique (page 19).

Contréle et actionne chaque canal pour la reproduction du morceau MIDI.

* Affiche le type général de sonorité (affichage uniquement).
» Détermine le réglage activé/désactivé (assourdissement) pour chaque canal.

@D Affiche I'apercu des données du morceau MIDI et vous permet de modifier les sections de
style.

* Affiche I'apercu des données de chaque canal pour un morceau MIDI (affichage uniquement).
* Modifie la section de style (page 20).
* Modifie l'affectation de canal MIDI pour chaque partie de style (page 24).

@2 Modifie I’'agrandissement de I’affichage de I’apercu des données de morceau MIDI (QD).

@3 Affiche un certain nombre de réglages de style et vous permet de les modifier (pages 17, 26).

* Tempo (affichage uniquement)

¢ Indication de la mesure (temps)

 Activation/désactivation et volume de chaque partie de style
* Touche de section

11



Fonctions (description de I'affichage)

B Affichage des réglages MIDI

MIDI Input Device

MIDI Output Device

(D Détermine MIDI Input Device.

(2 Détermine MIDI Output Device.
Si vous sélectionnez « MIDI Song to Style Synth », vous devrez également régler la destination de sortie audio.

(3® Actualise la liste de périphériques MIDI.

B Affichage des autres réglages

Style File

Total Max Size

Chord Palette

® Open and close automatically when style playing

(D Détermine la taille maximum des fichiers de style convertis.

(2 Détermine si la fenétre de palette d’accords (page 13) est automatiquement appelée lors de la
reproduction d’un style.

(3 Détermine s’il faut autoriser ou non la collecte de données anonymes relatives au statut
d’utilisation de cette application.
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Fonctions (description de I'affichage)

B Fenétre de palette d’accords

Cette fenétre vous permet de spécifier I'accord utilisé lorsque le style est reproduit.

C[D FIG]A]B

-_: e e_™") M M  r rer - k,k e
—————————— —————————————————————\\

On Bass
on—

Emin
os ]

(D Spécifie la note fondamentale de I’accord.

2 Spécifie le type d’accord.

L’abréviation « cc » signifie « chord cancel » (annulation d’accord) (aucun accord spécifié).

(3 Active/désactive I’'accord On Bass et vous permet de spécifier la note de basse.

@ Affiche I’'accord spécifié.

13



Fonctions (description de I'affichage)

B Fenétre de modification détaillée

Cette fenétre vous permet de modifier les réglages de canaux du morceau MIDI et de changer les réglages détaillés pour chaque

partie de la section de style.

"n 3 ’HA MB MC MD FA FB FC BK E1 fES E3

MelodyPart

Pd Pd Pd

M 12 13 VR ME NC MO TEATFETECTFD Bk E1 E2

®

(D Contrdle la reproduction du morceau MIDI.

(2 Active/désactive (assourdit) chaque canal MIDI.

(3 Réinitialise les réglages de canaux MIDI.

Rétablit le statut avant modification.

(@) Détermine la sonorité de chaque canal MIDI.
Vous pouvez la spécifier en sélectionnant des numéros de changement de programme ou des noms de sonorité.
La liste des sonorités importée (page 5) est utilisée pour le nom de sonorité.
Les couleurs attribuées aux numéros de sonorité ou aux noms de sonorité indiquent les conditions suivantes.

0 40 39 Touches Non modifié et la sonorité ne changera pas durant la
blanches | séquence.
0 113 31 Jaune Non modifié et la sonorité changera durant la séquence.

La sonorité a été réglée manuellement.

(5 Détermine le volume de chaque canal MIDI.

14



Fonctions (description de I'affichage)

(& Affiche le statut de volume de chaque canal MIDI.

Les trois types de conditions de volume sont indiqués comme suit.

Touches i .
Non modifié et le volume ne changera pas durant la séquence.
blanches
Jaune Non modifié et le volume changera durant la séquence.
- Orange Le volume a été réglé manuellement.

(@ Réinitialise tous les réglages de canaux MIDI.

Affiche le statut d’affectation de chaque canal pour la section et appelle les réglages détaillés
des parties de style.

Affiche les affectations des parties pour chaque canal dans chaque section du style.
Les abréviations suivantes sont utilisées sur l'affichage.

Nom de section

1a3 Intro 1 a lll
MA a MD Main AaD
FA a FD FiliInAaD
BK Break
E1aE3 Ending 1 a lll

Nom de la partie de style

R1, R2 Rhy1, Rhy2
Bs Bass
C1,C2 Chd1, Chd2
Pd Pad

P1, P2 Phr1, Phr2

Cliquez sur chaque nom de partie de style pour modifier les parameétres détaillés des parties dans chaque section.
Pour plus d’informations sur les paramétres détaillés, reportez-vous a la page 29.

NOTE

Les paramétres détaillés sont automatiquement réglés en fonction des résultats d’analyse ; par conséquent, il n'est normalement
pas nécessaire de les modifier.

15



Comment utiliser I’application

Reproduction (écoute) du style converti

Vous pouvez écouter le rendu sonore du style converti tout en spécifiant 'accord.

B Reproduction de styles

1. Cliquez sur I'icone de la section que vous souhaitez reproduire.

[ rnA J| FnB Fi G

FinD )

%) mioi

£ Setting

Dans cet exemple, la section Main B est reproduite.
En outre, la fenétre de palette d’accords (page 13) est automatiquement appelée par défaut.

2. Contrélez la reproduction du style, par exemple en modifiant des sections et en spécifiant des
accords.

 Si vous cliquez sur 'icéne d’une autre section, cette section sera reproduite.
¢ Vous pouvez vérifier le changement de son tout en spécifiant I'accord depuis la fenétre de palette d’accords ou depuis
linstrument préalablement réglé comme MIDI Input Device.

3. Cliquez sur I'icéne de la section en cours de reproduction pour interrompre la reproduction
du style.

Activation/désactivation de la reproduction en boucle de la section.

Par défaut, cette application est réglée de sorte que chaque section soit reproduite en boucle, ce qui vous permet de vérifier
les contenus du style. Ce comportement différe de celui des instruments habituellement dotés de la fonction style. Si vous
souhaitez modifier le comportement des sections qui ne sont normalement pas reproduites en boucle (Intro I a lll, Fill In Aa D,
Break et Ending | a Ill) de sorte qu’elles ne soient pas reproduites en boucle, cliquez sur le signe situé dans le coin supé-
rieur droit de I'icone. L’affichage passe a E (reproduction en boucle désactivée) et ces sections ne seront reproduites qu’une
seule fois, puis le style sera reproduit comme c’est habituellement le cas pour les claviers numériques dotés de la fonction
style.

16



Comment utiliser I'application

B Activation/désactivation de chaque partie de style pendant la reproduction

Sur I'écran d’accueil (Edit), vous pouvez activer/désactiver (assourdir) chaque partie.

Song: Sample_MIDI_Song.mid

Dans cet exemple, Chd1 et Chd2 sont désactivées.

17



Comment utiliser I'application

Enregistrement et transfert des styles convertis

Vous pouvez enregistrer les résultats de conversion sur l'ordinateur ou les transférer sur I'instrument connecté sous forme de
fichier de style (.sty).

1. Cliquez sur I'icone 8.

& MIDI Song to Style
File Edit Preference Help

( save to Computer ) Save to Instrument

| ]

NOTE

Si vous souhaitez annuler I'enregistrement, cliquez a nouveau sur l'icobne .

2 » Sélectionnez la méthode d’enregistrement souhaitée pour le fichier.

* [Save to Instrument] : Ceci transfere et enregistre les fichiers de style directement dans I'instrument.
Le fichier sera enregistré dans le dossier racine du lecteur utilisateur.

* [Save to Computer] : Ceci enregistre les fichiers de style sur I'ordinateur.

NOTE

Vous pouvez utiliser [Save to Instrument] uniquement lorsque I'ordinateur est connecté a l'instrument au moyen d’un cable USB.
Pour obtenir des instructions, reportez-vous a la page 3.

3. Suivez les instructions a I’écran pour procéder a I’enregistrement ou au transfert.
A) Pour [Save to Instrument] (transfert direct vers I'instrument)

Save to root folder
of the User drive.

Save to Instrument

[

Entrez un nom puis cliquez sur [Save to Instrument] pour démarrer le transfert.

B) Pour [Save to Computer] (enregistrement sur un ordinateur)
Lorsque la boite de dialogue d’enregistrement de fichier s’affiche, entrez un nom et enregistrez-le a 'emplacement

souhaité.
Utilisez un lecteur flash USB pour transférer les données vers l'instrument.

18



Comment utiliser I'application

Modification des présélections d’analyse automatique

Les conditions d’analyse des morceaux MIDI sont réglées automatiquement, mais cela peut entrainer des résultats décevants en
fonction des données MIDI particuliéres. Il est possible de modifier le réglage afin d’inclure ou non chaque canal dans I'analyse ;
vous pourrez ainsi analyser a nouveau les données et obtenir les résultats souhaités.

B Spécifiez manuellement les canaux que vous souhaitez exclure de I’analyse, puis
procédez a une nouvelle analyse

1. Réglez I’écran d’accueil en mode Edit.

[4 Edit

2. Cliquez sur [Reanalyze Setting].

»
L
W
&
]
B
< B
L4
S
8

L’affichage des réglages d’analyse est appelé.

3. Modifiez les réglages d’exclusion de canaux comme vous le souhaitez.

— U
MelodyPart

[
[JI]

Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd

O]

c1|ci|cifc1icct|clfctc cifci|ala|alci|calc|c

[

Bs Bs Bs Bs Bs Bs Bs Bs Bs Bs Bs Bs Bs Bs

[

Pl P1

[

2|l ae|ala 2 2ie|elela

[

R1

2 R2 R2 R2 R2 R2 R2 R2 R2 R2 R2 R2 R2 R2

BEEEEE

[ ]
[ ]

[ ]

[ ]

[ ]

[ ]

[ ]

[ ]
[ ]

[ ]

[ ]

[ ]

[ ]

[ ]

[ ]

[

Cochez les cases des onglets [Melody] et [Assign] comme nécessaire.
* Onglet [Melody] : Les canaux cochés seront considérés comme « mélodie principale ».
Les canaux mélodiques principaux sont utilisés pour estimer la plage de section.
Lorsque vous cochez I'onglet [Melody], 'onglet [Assign] se décoche automatiquement.
Pour la valeur initiale, les résultats de I'identification automatique de la mélodie principale sont affichés.
Cochez les canaux que vous souhaitez spécifier pour la mélodie principale (par exemple, le canal contenant les
notes que vous souhaitez reproduire).
¢ Onglet [Assign] : Les canaux cochés sont les parties qui peuvent étre affectées aux parties de style.
Si vous ne souhaitez pas inclure le son de performance d’un canal spécifique dans le style converti, décochez ce
canal.

4. Cliquez sur [Reanalyze] pour réaliser une nouvelle analyse.
Les résultats de conversion seront mis a jour.
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Comment utiliser I'application

Modification du style converti

En mode Edit (page 11) sur I'’écran d’accueil, vous pouvez modifier un style automatiquement converti si cela est nécessaire afin
d’obtenir le résultat de conversion souhaité.

NOTE

Les opérations de modification présentées dans ce chapitre peuvent étre annulées ou rétablies a 'aide de [Edit] -> [Undo]/[Redo] dans le
menu situé en haut de I'application.

B Modification de la plage des sections

1. Cliquez sur le nom de la section en haut de I'affichage et sélectionnez la section dont vous
souhaitez modifier la plage.

La section sélectionnée est mise en surbrillance. Dans cet exemple, Intro 1l a été sélectionnée.

2. Faites glisser I’extrémité droite ou gauche de la plage de section pour ajuster la plage comme
souhaité.

Intro I Intro ll

La plage de la section a été modifiée.
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B Réorganisation des sections

Si les résultats d’affectation automatique des sections n’apparaissent pas dans I'ordre souhaité, vous pouvez réorganiser les

sections.

1. Cliquez sur le nom de la section en haut de I’affichage afin de sélectionner la section que
vous souhaitez repositionner.

La section sélectionnée est mise en surbrillance. Dans cet exemple, Main D est sélectionnée.

2. Cliquez a nouveau sur le nom de la section sélectionnée.

La fenétre contextuelle d’affectation de sections est appelée.

3. Sélectionnez le nom de la section souhaitée comme destination de remplacement, puis
cliquez sur [Assign] pour confirmer.

L’affectation de la section a été modifiée. Dans cet exemple, Main A et Main D ont été repositionnées.

NOTE
Vous pouvez conserver un effet naturel en repositionnant la section Main et la section Fill In comme un ensemble.

Pour maintenir une sensation naturelle, repositionnez la section Main et la section Fill In comme un ensemble. Par exemple, lorsque
vous remplacez Main B par Main C, vous devriez également remplacer Fill B par Fill C pour assurer la cohérence entre les motifs.
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B Affectation (manuelle) d’une nouvelle section

Vous pouvez spécifier la plage que vous souhaitez affecter a une nouvelle section.

1. Sur I'affichage, sélectionnez la plage que vous souhaitez affecter.

Intro I

La plage sélectionnée s’affiche.

2. Cliquez surl + 1.

Ending

La fenétre contextuelle d’affectation de sections est appelée.

3. Sélectionnez le nom de la section a laquelle vous souhaitez affecter la plage sélectionnée,
puis cliquez sur [Assign] pour confirmer.

¢ Lorsque vous sélectionnez une section n’ayant encore aucune affectation, une nouvelle section est ajoutée.
¢ Lorsque vous sélectionnez une section dotée d’affectations existantes, la section existante est supprimée et remplacée

par la nouvelle plage.

Intro |

Dans cet exemple, la plage sélectionnée vient d’étre ajoutée en tant que Intro I.
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B Suppression de sections

Vous pouvez supprimer les sections inutiles.

1. Cliquez avec le bouton droit de la souris sur le nom de la section que vous souhaitez
supprimer.

t Intro Il )

b
Delete Intro il

Ceci appelle un menu de suppression.

2. Cliquez sur [Delete <nom de la section>].
La section est alors supprimée.
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B Modification de la combinaison parties/canaux MIDI au sein d’une section

L’affectation pour laquelle des canaux MIDI individuels sont convertis en parties de style spécifiques peut étre modifiée
indépendamment pour chaque section.

1. Cliquez sur le nom de la section en haut de I’affichage afin de sélectionner la section que
vous souhaitez modifier.

Le statut d’affectation du canal pour chaque partie de la section sélectionnée s’affiche.

2. Faites un glisser-déposer de la partie dont vous souhaitez modifier I’affectation.

La partie source et la partie destination du glisser-déposer ont été repositionnées.

Suppression ou ajout de parties a I'intérieur d’une section
Vous pouvez supprimer une affectation de partie en cliquant sur l'icone [-] a c6té du nom de la partie.

Une icone [+] s’affiche pour les canaux sans affectation dont les données de performances entrent dans la plage de la section.

Cliquez sur cette icone [+] pour sélectionner et affecter une partie de section.

Rhy1 Rhy2 Bass
Chd1 Chd2- Pad

Phr1 Phr2
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B Modification de la sonorité pour chaque canal d’'un morceau (modification

détaillée)

Vous pouvez remplacer les sonorités génériques spécifiées dans un morceau MIDI par des sonorités de meilleure qualité

spécifiques a I'instrument.

1. Sélectionnez [Edit] -> [Open DetailEdit Window] dans le menu situé en haut de I’application.

La fenétre de modification détaillée est appelée.

2. Modifiez les réglages de sonorité pour chaque canal.

13 'MA MB MC MD

MelodyPart

Pd Pd

Pd

Pd

c1crjc1|ct

Bs Bs

c2

R2 R2 R2

P1

12 15 TWRWE WiC WD TERVEBIRETRD ek £1 E2 €3

Bs

P

BK E1/E2 E3

Vous pouvez les régler en utilisant des numéros de changement de programme ou des noms de sonorité.
La liste des sonorités importée (page 5) est utilisée pour le nom de sonorité.
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B Modification/réinitialisation du volume pour chaque partie d’un style

Vous pouvez modifier le volume de chaque partie de style dans toutes les sections.

Song: Sample_MIDI_Song.mid

O\ @aENsss

Pour ajuster le volume de chaque partie, utilisez les boutons situés sous les noms de parties de style. Vous pouvez également
modifier directement les valeurs.

Si vous souhaitez réinitialiser le volume modifié pour le ramener a son statut initial ('état dans lequel il se trouvait lors du

chargement du morceau MIDI), effectuez I'une des opérations suivantes :

¢ Dans le menu situé en haut de I'application, ouvrez [Edit] -> [Reset Style Parameter] -> [Volume], puis sélectionnez la partie
que vous souhaitez réinitialiser.

* Maintenez la touche CTRL (Windows) ou Command (Mac) enfoncée, et cliquez sur le bouton correspondant a la partie que
vous souhaitez réinitialiser.

Si vous souhaitez restaurer la modification précédemment annulée, sélectionnez [Edit] -> [Undo].

B Modification du temps du style (indication de la mesure)

Vous pouvez modifier les réglages de temps du style (indication de la mesure) une fois la conversion réalisée.

I

Cliquez sur la zone « Beat » en bas de I'écran et réglez la valeur.

B Modification de la touche de section de style

Section key (Section Key Signature) est un paramétre qui indique sur quelle touche sont basées les données de chaque section.
Si vous spécifiez des accords ayant la méme note fondamentale que cette touche pendant la reproduction de style, les sections
Intro et Ending seront reproduites avec la méme hauteur de son que le morceau MIDI avant la conversion. Sélectionnez le nom

de la section que vous souhaitez modifier en haut de 'affichage, puis cliquez dans la zone « Section Key » en bas de I'affichage
pour régler la valeur.




Annexe

Terminologie

B Morceaux MIDI (SMF)

* Données de partition musicale au format électronique. Le fait de charger de telles données dans un périphérique compatible
permet de reproduire la musique.

¢ Inclut 16 « canaux » vous permettant de spécifier plusieurs sonorités (son d’instruments), volumes et performances.

* SMF (fichier MIDI standard) (.mid) est le nom du format standard pour les fichiers MIDI.

B Termes relatifs au style

Section :

Groupe collectif de données musicales (ou motifs) utilisé pour élaborer un morceau.

En fonction de la progression de la performance ou du morceau, les sections changent de maniére automatique ou manuelle.
Les sections incluent Intro I-11l, Main A-D, Fill In A-D, Break et Ending I-lll.

Exemple de reproduction :

Obération INTRO START/ MAIN ENDING
peratl [1 STOP [B] (i1
Reproduction de sty Intro | Main A Fill In B Main B | Ending Il St
eproccton de style "| (une fois) " (en boucle) " (une fois) "|(en boucle) " (une fois) op

NOTE

Lors de la conversion automatique dans MIDI Song to Style, il reste toujours certaines sections (Intro |, Break, Ending |, Ending Ill) sans
affectation ; il est donc nécessaire (et souhaitable) de les affecter manuellement.

Partie :

Composante d’une section. Les sonorités, etc. peuvent étre réglées individuellement pour chaque section. Les parties équivalent
aux canaux dans un morceau MIDI.
Les parties incluent Rhythm 1-2, Bass, Chord 1-2, Pad et Phrase 1-2.

Fichier de style :
Le format de fichier de style (SFF) est un format lié a la fonction d’accompagnement automatique de Yamaha (style).
Il existe deux formats : SFF et SFF GE.
SFF GE (Guitar Edition) est un format étendu du SFF qui renforce I'expressivité des sonorités de guitare.
MIDI Song to Style exporte les fichiers de style au format SFF GE.

Main A Main B
| Rhythm 1 | | Rhythm 1 |
| Rhythm 2 | | Rhythm 2 |
| Bass || || oBass |
| chod1 || || chod1 || ..
| chod2 || || chord2 |
| Pad  |||| Pad |
| Phrase1 || || Phraset |
| Phrase2 || || Phrase2 |
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Menu

Description

Open SMF

Charge les fichiers de morceau MIDI (.mid, .midi).

Save Style File

Enregistre le fichier de style converti sur l'ordinateur.

Open Project

Charge le fichier de projet (.sts) et reproduit le statut de modification au moment de
'enregistrement.

File
. Enregistre le projet en cours de modification dans un fichier de projet au format
Save Project e
propriétaire (.sts).
Recent Files Sélectionne les fichiers récemment ouverts.
Exit (Quit)* Quitte I'application.
Undo Rétablit le statut de modification précédent.
Redo Aprés avoir utilisé Undo, rétablit le statut de modification avant annulation.
Open DetailEdit Window Ouvre la fenétre de modification détaillée.
Edit Importe la liste des sonorités.
Import Voice List NOTE
La liste des sonorités est utilisée lorsque vous spécifiez des sonorités dans la fenétre
de modification détaillée.
Reset Style Parameter Volume Réintialise le volume pour chaque partie du style.
Manual Affiche le mode d’emploi (ce manuel).
Help Privacy Statement Affiche la politique de confidentialité.

About*

Affiche la version de I'application ainsi que les informations relatives aux droits
d’auteur.

* Sur la version pour Mac, ce menu se trouve dans le menu de 'application « MIDI Song to Style ».
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Raccourcis clavier

Opération Raccourci

Charger un fichier de morceau MIDI (.mid) Ctrl + Maj + O
Enregistrer un fichier de style (.sty) Ctrl + Maj + S

Charger un fichier de projet (.sts) Ctrl+ O

Enregistrer un fichier de projet (.sts) Ctrl+ S

Annuler Ctrl + Z

Rétablir Ctrl + Maj + Z

Ouvrir 'affichage de modification détaillée Ctrl + Maj + D
Reproduire/interrompre un morceau MIDI Barre d’espacement

NOTE
* |l est possible que les raccourcis clavier ne soient pas immédiatement disponibles aprés avoir entré des chiffres sur le clavier. Le cas
échéant, cliquez une fois n’importe ou sur I'écran pour activer les raccourcis.

e Sur Mac, utilisez la touche Command au lieu de la touche Citrl.

Fenétre de modification détaillée : modification des parameétres de
section

La fenétre de modification des parametres de section est appelée lorsque vous cliquez sur une partie dans une section dans la
fenétre de modification détaillée (page 14).

Section Setting MainC ¥

Key Signature GMaj ¥

Style Part
Zone Setting
Lo Zone Main Zone Hi Zone
Split - B Meg
Style Playing Parameter Style Playing Parameter
Guitar Stroke ¥
Convert to Style Parameter Convert to Style Parameter

no change v Guitar Stroke ¥

HiKey 1(0CH v HiKey 7(aQ)

HiLim 127 (G8) ¥ HiLim 127 (G8)

LoLim 28(E0) ¥ LoLim 0(C-2)

Cancel
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B Descriptions de chaque élément de I’affichage

Nom de I’élément

Description

Section Setting —

Change la section a modifier.

Pour cet élément uniqguement, le nom de section differe de 'affichage normal.
Remplacez les noms de sections par ce qui suit lorsque vous voyez :

¢ Intro A-C : Intro |-l

* Fill In AA-DD : Fill In A-D

« Fill In BA : Break

¢ Ending A-C : Ending I-lI

Key Signature

Détermine la Section Key Signature.

Channel Setting — Change le canal MIDI devant étre modifié dans la section sélectionnée.
Attribute Affiche les attributs du canal (résultats d’analyse automatique).
Style Part Affiche I'affectation de partie du canal sélectionné dans une section.
Zone Setting — Divise la zone et définit le fonctionnement des canaux qui apparaissent au-
dessus (parties de style affectées aux canaux) sur une plage de section.
Lo Zone Split Détermine ou séparer la Lo Zone et la Main Zone.
Entre la valeur de touche la plus basse (-, 1 a 127) de la Main Zone.
Si la valeur affiche « - », les réglages de la Lo Zone sont désactivés.
Style Playing Affiche le Style Playing Parameter pour la Lo Zone (le réglage et les
Parameter modifications automatiques ne sont pas autorisés).

Convert to Style
Parameter

Détermine les régles de conversion des notes pour la Lo Zone lors de la
conversion vers un style.
Il existe quatre options : Root only, Active for Main, Semi-active Bass et -.

HiKey
(High Key)

Détermine la valeur standard (0 a 11 : C a B) pour déterminer s'il faut transposer
vers le haut ou vers le bas lors de la reproduction du style pour la Lo Zone.

Si une note plus haute que cette valeur est spécifi€¢e comme note fondamentale
d’accord pendant la reproduction, la transposition se fera vers le bas.

LoLim
(Low Limit)

Détermine la valeur de transposition minimum (0 a 127) pendant la reproduction
de style pour la Lo Zone.

Si le résultat du calcul de transposition devient inférieur a cette valeur pendant la
reproduction, des actions telles que la répétition d’octave ou l'interruption du son
seront effectuées en fonction du Style Playing Parameter.

HiLim
(High Limit)

Détermine la valeur de transposition maximum (0 a 127) pendant la
reproduction de style pour la Lo Zone.

Si le résultat du calcul de transposition devient supérieur a cette valeur pendant
la reproduction, des actions telles que la répétition d’octave ou linterruption du
son seront effectuées en fonction du Style Playing Parameter.
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Nom de I'élément Description
Zone Setting Main Zone Style Playing Détermine le Style Playing Parameter pour la Main Zone.
Parameter
Convert to Style Détermine les régles de conversion des notes pour la Main Zone lors de la
Parameter conversion vers un style.
HiKey Détermine la valeur standard (0 a 11 : C a B) pour déterminer s’il faut transposer
(High Key) vers le haut ou vers le bas lors de la reproduction du style pour la Main Zone.

Si une note plus haute que cette valeur est spécifiée comme note fondamentale
d’accord pendant la reproduction, la transposition se fera vers le bas.

LoLim Détermine la valeur de transposition minimum (0 a 127) pendant la reproduction
(Low Limit) de style pour la Main Zone.

Si le résultat du calcul de transposition devient inférieur a cette valeur pendant la
reproduction, des actions telles que la répétition d’octave ou l'interruption du son
seront effectuées en fonction du Style Playing Parameter.

HiLim Détermine la valeur de transposition maximum (0 a 127) pendant la

(High Limit) reproduction de style pour la Main Zone.

Si le résultat du calcul de transposition devient supérieur a cette valeur pendant
la reproduction, des actions telles que la répétition d’octave ou l'interruption du
son seront effectuées en fonction du Style Playing Parameter.

Hi Zone Mega Voice Détermine s’il faut appliquer un traitement MegaVoice sur les notes de la Hi
Zone (C6 ou supérieures).

Les notes C6 ou supérieures cochées ne seront pas converties et continueront a
étre jouées correctement lors de I'utilisation de MegaVoice.

31



Annexe

B A propos de Style Playing Parameters

Il n’existe pas de regles de conversion des notes permettant a chaque partie d’une section de correspondre a une spécification
d’accord pendant la reproduction du style.
Le fait de choisir des présélections correspondant aux caractéristiques de chaque partie garantira la qualité et la précision de

votre performance.

Nom de la présélection

Description

Bass

Pour la partie de basse de la section Main/Fill.

Bass (Intro)

Pour la partie de basse de la section Intro/Ending.

Chord

Pour une partie principalement composée d’accords de plusieurs notes de la section Main/Fill.

Phrase chordal

Pour une partie principalement composée d’une seule note, d’accords dispersés (arpeges, etc.) de la section
Main/Fill.

Phrase melodic

Pour une partie principalement composée de phrases mélodiques d’'une seule note de la section Main/Fill.

Pour une partie utilisant une sonorité de guitare et principalement composée d’accords de plusieurs notes de

Guitar Stroke la section Main/Fill.
. . Pour une partie utilisant une sonorité de guitare et principalement composée d’une seule note, d’accords
Guitar Arpeggio . . N . .
dispersés (arpeges, etc.) de la section Main/Fill.
Chromatic Pour une partie principalement composée de phrases de gamme chromatique de la section Main/Fill.

Maj-min (Intro)

Pour une partie autre que la partie de basse et Phr1-2, de la section Intro/Ending.

Drum with cymbal

Pour une partie utilisant un kit de batterie avec cymbale crash.

Drum no cymbal

Pour une partie utilisant un kit de batterie sans cymbale crash.

SFX

Pour une partie utilisant un kit SFX.

Aucune affectation (s’il n’y a aucune affectation de partie).

NOTE

Les parties réglées sur Bass (Intro) ou Maj-min (Intro) sont fortement influencées par la touche de section de cette partie.

B A propos de Convert to Style Parameters

Voici les régles qui s’appliquent & la conversion des notes des canaux en notes des parties de style.

Nom de la présélection

Description

no change Les notes ne seront pas modifiées.
Root only Seule la note fondamentale de 'accord est reproduite.
Root & 5th Seule la note fondamentale de I'accord et la quinte parfaite sont reproduites.

Semi-active Bass

La performance d’origine est reproduite avec certaines limites éventuelles.
La stabilité générale et la pertinence des spécifications d’accords pendant la
reproduction de style peuvent étre inférieures a celles de « Root Only ».

Stable for Main

Certains accords spécifiques de plusieurs notes peuvent étre reproduits de
maniére stable pendant la reproduction de style.

Cependant, la performance d’origine risque de ne pas étre reproduite
fidelement.

Active for Main

Si les résultats d’analyse d’accord sont adéquats durant I'analyse, la
performance d’origine sera fidélement reproduite. En cas d’erreurs dans les
résultats d’analyse d’accord, le style converti sera inapproprié musicalement.

Guitar Stroke

Réglages propres a « Guitar Stroke ».

Guitar Arpeggio

Réglages propres a « Guitar Arpeggio ».
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Les options Convert to Style Parameter changent en fonction des réglages Style Playing Parameter, comme indiqué dans le

tableau ci-dessous.

Style Playing Parameter

Bass

Bass
(Intro)

Chord

Phrase
chordal

Phrase
melodic

Guitar
Stroke

Guitar
Arpeggio

Chromatic,

Maj-min (Intro),
Drums with cymbals,
Drums without
cymbals, SFX

Convert to Style
Parameter

no change

O

Root only

Root & 5th

Semi-active
Bass

Stable for
Main

Active for
Main

Active root
only

Active root &
5th

Guitar Stroke

Guitar
Arpeggio
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Si I'application ne fonctionne pas correctement, vérifiez les points suivants pour déterminer si les mesures simples suggérées

permettent de corriger le probléme.

Problémes

Causes possibles

Solutions

Impossible d’enregistrer (de transférer) des
fichiers dans l'instrument bien que
I'application soit connectée a l'instrument.

Aucun instrument n'est réglé pour MIDI
Input/Output Device.

Assurez-vous que l'instrument connecté est
correctement réglé sur MIDI Input/Output
Device dans les réglages.

Impossible de spécifier des accords depuis
l'instrument pendant 'apergu de style, bien
que I'application soit connectée a
linstrument.

L’'TACMP] est activé co6té instrument.
Lorsque 'TACMP] est activé, les informations
relatives aux accords sont uniquement
envoyées a l'instrument, et pas a
I'ordinateur.

Désactivez '[ACMP] sur 'instrument.

L’affichage de I'application s’assombrit.

La fenétre est maximisée. Si vous utilisez
I'application avec la fenétre maximisée, une
distorsion risque de se produire dans les
autres fenétres en raison du fonctionnement
du systéme d’exploitation.

* Appuyez sur la touche [ESC] pour annuler
la maximisation de la fenétre.

 Utilisez I'application sans maximiser la
fenétre.
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